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MPiste-ohje versioon 2.4

Yleistä
Olet tutustumassa Progecad- suunnitteluohjelman liitännäisohjelmaan, jonka 
avulla voit luoda piirustukseen mittapisteitä, tuoda mittapisteitä 
koordinaattilistalta ja viedä mittapisteiden koordinaattitiedot tekstimuotoiseen 
tiedostoon. MPiste- ohjelma ei toimi ilman Progecadin asennusta.

Käyttöympäristön vaatimukset
Ohjelma on testattu käyttöjärjestelmissä Windows XP Home ja Pro, Vista ja 7.

Progecad versiot 2009 Pro ja 2010 Pro on testattu. MPiste saattaa toimia myös 
muilla Intellicad-pohjaisilla cad-ohjelmilla, missä on VBA-tuki (Visual Basic for 
Applications). Useissa tapauksissa vaaditaan ns. Professional-versio.

Asennus
1. Tallenna lataamasi asennusohjelma tietokoneellesi ja käynnistä se. 

Hyväksy harkiten Windowsin varoitukset. Asennusohjelma tallentaa 
tarvittavat tiedostot kansioon C:\MPiste

2. Kopioi tiedostot MPiste_button.bmp, MPiste.mnu ja mpisteload.lsp 
samaan kansioon, missä on icad.exe. Oletusasennuskansio Progecadilla 
on C:\Program files\progeSOFT\progecad 20xx Professional ENG.

3. Avaa Progecad

4. Asenna MPiste-menu eli valikko valitsemalla Tools->Customize->Menu

5. Paina Import ja valitse tiedostomuodoksi *.icm

6. Varmista että alalaidan kohdassa Append to current menu on rasti

7. Etsi C:\MPiste- kansiosta MPiste_menu.icm

8. Poistu Customize- ikkunasta ja paina Close

9. Asenna MPiste painike. Valitsemalla Tools->Customize->Menu. Avaa 
välilehti Toolbars.

10. Paina Import ja valitse tiedostomuodoksi *.mnu

11. Varmista, että alalaidan kohdassa Append to existing toolbars on 
rasti

12. Etsi Progecadin asennuskansiosta MPiste.mnu- tiedosto

13. Asenna Lisp-ohjelma valitsemalla Tools->Load lisp or SDS 
Application

14. Paina Add File ja etsi  C:\MPiste- kansiosta mpisteload.lsp-tiedosto. 
Avaa tiedosto ja valitse Load Application Files- ikkunassa Load.
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15. Edelliset kohdat tehdään vain kerran ensiasennusvaiheessa.

16. Ohjelma on nyt valmis toimimaan. Valitse MPiste-valikosta Mpiste 
tai paina MPiste-painikkeesta. Voit siirtää painikkeen  työkaluosioon 
pois piirustusalueelta. 

17. Voit kokeilla ohjelmaa 10 käyttökertaa 
ennen kuin tarvitset käyttöoikeuskoodin. 
Käyttöoikeuskoodin saaminen edellyttää 
ohjelmalisenssin hankkimista.

Mikäli saat myöhemmin virheilmoituksen ”load 
failed”, niin kopioi tiedosto mpisteload.lsp samaan 
kansioon, missä on Progecadin pääohjelma icad.exe. 
Oletusasennuskansio Progecadilla on C:\Program 
files\progeSOFT\progecad 20xx Professional ENG.

Huomioi seuraavat asetukset Progecadissa:

-avaa menusta Tools->Options

-General- välilehdellä kohdassa 
VBA Security rasti pois

-Experience level Advanced

- General- välilehdellä kohdassa 
Advanced settings rasti kohtaan 
Enable VBA events

- hyväksy OK ja sulje Progecad ja 
käynnistä se uudelleen. 

Rasti pois

Rasti päälle
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Ominaisuudet
MPiste luo piirustukseen mittapistesymbolin. Symboli on tyypiltään block 
(kokoelma piirustusobjekteja), jolla on kolme attribuuttitietoa. Attribuuttitiedot 
ovat pistenumero, koodi ja korkeus. Itse mittapistesymboli sisältää 
mittapisteen tasokoordinaattitiedon. MPisteellä voidaan luoda erilaisia valmiita 
symbolimerkkejä (tässä versiossa 9 kpl). Jokainen symboli voidaan piirtää 12 
eri värillä. Näin ollen käytettävissä on 108 erilaista symboli-väri-yhdistelmää. 
Jokainen yhdistelmä muodostaa oman mittapisteryhmän, jota voidaan käsitellä 
joukkona. Vie tiedostoon- ja Poista mittapisteitä-toiminnot käyttävät em. 
mittapisteryhmiä valitessaan kohteita toimintoihin.

Jokainen mittapisteiden symboli-väri-yhdistelmä luo piirustukseen omat 
yksilölliset kuvatasot. Punainen ristisymboli luo kuvatasot

-M11KOODI

-M11KORKEUS

-M11PISTEET

-M11PISTENUMERO

-M11SYMBOLI
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Käyttämällä Entity Properties-toolbar toimintoa Layer voidaan jokaisen 
mittapistejoukon näkyvyyttä säätää yksilöllisesti. Esimerkiksi koodi ja korkeus-
attribuuttien näkyminen voidaan estää vain punaiselta ristisymbolilta ja jättää 
ne näkyviin muissa mittapistejoukoissa.

Käytä attribuuttitiedon piilottamiseen freeze ja 
thaw-toimintoa ja lukitukseen lock/unlock-toimintoa. 
Voit piilottaa koko mittapistejoukon jäädyttämällä 
M11PISTEET-kuvatason.

MPiste lukitsee kaikki mittapisteitä koskevat 
kuvatasot automaattisesti, jotta vältytään 
tahattomasti siirtämästä mittapisteitä. Tämä lukitus 
ei estä mittapisteiden tallentamista tiedostoon tai tuomasta uusia pisteitä 
samalle kuvatasolle. Se ei myöskään estä poistamasta pisteitä MPisteen 
toiminnolla Poista mittapisteitä.

Mittapistejoukkojen käsitteleminen MPiste-ohjelmalla on mahdollista niin 
kauan kuin ohjelman luomat kuvatasonimet säilyvät ennallaan. Niitä ei siis 
pidä muuttaa harkitsemattomasti tai ohjelman toiminnallisuus saattaa kärsiä. 
MxxPISTEET- kuvatasonimen perään voidaan liittää käyttäjän määrittämä 
loppuliite, kun mittapisteitä luodaan tai tuodaan tiedostosta. On mahdollista 
myös manuaalisesti muuttaa ko. kuvatason nimi, mutta vain lisäämällä 
alkuperäisen nimen perään loppuliite.

MPiste luo piirustukseen mittapisteblokin. Jokaisen erilaisen symboli-väri-
yhdistelmän mukainen mittapisteblokki on nimetty yksilöllisesti samaan tapaan 
kuin kuvatasotkin. Em. tapauksessa luotu blokki on nimeltään M11PISTE. Tätä 
mittapisteblokin nimeä ei tule muuttaa, koska ohjelman toiminnollisuus 
saattaa  kärsiä.

MPiste käyttää tällä hetkellä mittapisteiden tallennusmuotona tekstimuotoista 
listausta, joka sisältää riveittäin pilkulla erotettuna Pistenro, X, Y, H(, koodi). 
Tämä tiedosto voi olla tiedostopäätteeltään csv, pts tai txt. Tiedostoa voi 
tarkastella esim. tekstieditorilla ja useimmat mittausohjelmat ja mittalaitteet 
lukevat samaa tiedostomuotoa. MPiste kirjoittaa Vie tiedostoon-toiminnossa 
aina myös koodin vaikka sitä ei edellytetä silloin , kun tiedosto luetaan 
ohjelmaan. 

Huomaa, että tietojen erottimena on pilkku ja desimaalierottimena on piste. 
MPisteellä luotaessa pisteitä käyttäjän antamilla koordinaateilla, voidaan 
kuitenkin käyttää desimaalierottimena pilkkua. Ohjelma muuntaa sen 
pisteeksi.
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On myös huomattava, että kaikki koordinaattitiedot ovat aina metreinä 
tiedostossa vaikka ne voivat olla piirustuksessa millimetreinä.

Mittapisteiden luomisessa on vielä joitakin ominaisuuksia, joita käsitellään 
tarkemmin kohdassa Toiminnot.

MPisteen käyttöliittymänä on valikosta aukeava 
ikkuna, joka sijoittuu kuvaruudun oikeaan laitaan. 
Ikkunaa voi vapaasti siirtää.

Ikkunassa on neljä toimintopainiketta ja useampi 
valintaruutu sekä tietojensyöttölaatikko.

MPiste tallentaa useimmat valinnat ja tiedot, joten 
niitä kaikkia ei tarvitse valita joka kerta ohjelmaa 
käynnistettäessä.

On valittava jo alkuvaiheessa toimitaanko 
piirustuksessa metri vai millimetripohjalla ja tehdään 
sen mukainen valinta ennen toiminnon suorittamista. 

Mittapisteen näyttämä korkeustieto on aina metreinä 
näytetty vaikka piirustuspohja olisikin millimetreissä.

Valinnalla Keskitä autom. voit 
keskittää ikkunan tuotuasi tai 
tehtyäsi mittapisteitä. 
Toiminta on sama kuin 
zoom_extents.

Voit myös piilottaa eli 
jäädyttää mittapisteen 
attribuuttitietoja tuonnin tai 
mittapisteen luonnin 
yhteydessä. Tämän toiminnon 
voi toki suorittaa 
tasohallinnan kautta.

Pistenumeron numero-osa on juokseva numero, joka 
kasvaa automaattisesti.

 Pistenumeroon voidaan liittää vakiona pysyvä etu- tai 
jälkiliite.

Mittapisteen symbolin ja pistenumeron piirtämisen 
viivanleveys voidaan paksuntaa valinnalla Paksu 
symboli ja pistenumero.

Symbolin koko voidaan pienentää puoleen valinnalla 
Pieni symboli. Samoin tekstin koko voidaan puolittaa.

Tässä versiossa on käytössä vain yksi tiedostomuoto.
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Toiminnot
MPiste- ohjelmassa on neljä toimintoa, jotka käynnistyvät painikkeista. Ennen 
toimintojen käynnistämistä tulee tehdä muutamia asetuksia. Tarvittavat 
asetukset jokaisessa toiminnossa selvitetään jokaisen toiminnon kohdalla.

Jokaisen toiminnon selostuksessa käydään läpi kaikki mahdolliset valinnat ja 
tietojen syöttömahdollisuudet. Järjestyksen ei tarvitse olla sama.

Tuo tiedostosta

• Valitse, jos tuot mittapisteet metripohjaiseen piirustukseen ts. 
piirustukseen, jonka piirustusyksikkö on metri. Mikäli piirustuksen 
piirustusyksikkö on millimetri, poista valinta ruudusta Tuo metripohjalle

• Voit halutessasi käyttää koodilistaa alla olevien asetusten tekemiseen, 
katso kohtaa Koodilista ja Koodilista tuo mittapisteet toiminnossa.

• Valitse symbolin koko. Voit valita valmiin arvon pudotusvalikosta tai 
kirjoittaa haluamasi koon. Symbolin koko ilmoitetaan aina millimetreinä. 
Koko on symbolin halkaisija ja samalla mittapisteen attribuuttitietojen 
tekstin korkeus.

• Valitse mittapisteen symboli. Tässä versiossa on käytössä 9 valmiiksi 
määritettyä symbolia. Valinnan kohdalla oikeanpuoleisin ruutu näyttää 
symbolin nimeä vastaavan numeron, joka tulee myös mittapisteblokin 
nimeen ja mittapisteen kuvatason nimeen.

• Valitse mittapisteen väri. Tässä varsiossa on käytössä 12 eri väriä, jotka 
pitää valita pudotusvalikosta. Valinnan kohdalla oikeanpuoleisin ruutu 
näyttää symbolin väriä vastaavan numeron, joka tulee myös 
mittapisteblokin nimeen ja mittapisteen kuvatason nimeen.

• Valinnainen oma tasonimi, joka lisätään MxxPISTEET-kuvatason nimen 
perään. Ohjelma kirjoittaa kuvatason nimen ja oman nimen väliin ”_”-
merkin.

• Valitse, haluatko paksun symbolin ja pistenumeron. Mikäli piirustuksessa 
on jo määritetty sama mittapisteblokki (sama symboli - ja 
väriyhdistelmä), niin tämä valinta ei muuta aikaisemmin tehtyä valintaa. 
Mittapisteblokin määritykset voi muuttaa poistamalla mittapisteblokki ja 
tekemällä se uudelleen.

• Valitse, haluatko pienen symbolin. Pieni symboli on kooltaan puolet 
alkuperäistä pienempi. Tekstien koot säilyvät ennallaan. Tätä määritystä 
koskee myös edellä mainittu.

• Valitse, haluatko pienen tekstin. Pieni teksti on kooltaan puolet 
alkuperäistä pienempi.

• Valitse Koordinaatit pistenumeron ja koodin tilalle, jos haluat että 
mittapisteen pistenumeron ja koodin sijaan kirjoitetaan mittapisteen 
koordinaatit. 
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• Keskitä automaattisesti- toimintoa voi käyttää, jos haluaa kuvaruutuun 
näkyviin kaikki piirustuksen sisältämät kohteet.

• Lukitse automaattisesti- toimintoa voi käyttää, jos haluaa mittapiste- 
kuvatason lukittuvan pisteiden tekemisen jälkeen.

• Jäädytä kuvatasot- toimintoa voit käyttää silloin, kun haluat piilottaa 
mittapisteen attribuuttitietoja. Tämä toiminto vaikuttaa vain niihin 
mittapisteisiin, mitä ollaan juuri käsittelemässä.

• Nyt on kaikki mahdolliset valinnat tässä toiminnossa tehty ja voit painaa 
Tuo tiedostosta- painiketta. Mikäli Symbolin koon valinta unohtui tehdä 
ts. Symbolin koko– ruutu on tyhjä, niin Avaa pistetiedosto- ikkuna ei 
avaudu. Valitse oikea tiedosto. Voit valita tiedostotyyppi- kohdasta, 
minkä päätteiset tiedostot näkyvät tiedostolistassa. Oletuksena on csv. 
Paina valinnan jälkeen Avaa- painiketta. Mittapisteet luodaan 
piirustukseen tekemiesi valintojen mukaisina. Komentoikkunassa 
(Command bar) ilmoitetaan montako mittapistettä on tuotu 
piirustukseen. Komentoikkunan saat näkyviin Valikosta View->Display-
>Command bar.

Vie tiedostoon

• Valitse ensin vietkö mittapisteet metripohjaisesta vai 
millimetripohjaisesta piirustuksesta.

• Paina Vie tiedostoon- painiketta.

• Valitse mittapisteitä- ikkuna avautuu. Tee tässä ikkunassa valinnat, 
mitkä mittapisteet haluat viedä tiedostoon. Valinta tehdään valitsemalla 
pudotusvalikoista mittapisteet symboli ja väri tai piirustuksessa käytetyn 
mittapistekuvatason mukaan ja painamalla Valitse- painiketta. Mikäli 
valittu mittapisteblokki löytyy piirustuksesta, niin sen kuvatasonimi 
ilmestyy alla olevaan tekstilaatikkoon. Voit nyt valita myös useamman 
mittapistejoukon. Mikäli valittua mittapisteblokkia ei löydy 
piirustuksesta, tulee näkyviin ilmoitus. Valittu mittapisteblokki voi olla 
olemassa piirustuksessa vaikka mittapisteitä ei ole kuvaruudussa. Tällöin 
tulee myös ilmoitus, että mittapisteitä ei löytynyt.

• Kun tarvittavat mittapistejoukot on valittu, paina Jatka- painiketta. Nyt 
avautuu Tallenna mittapisteet- ikkuna, jossa voit valita tallennuspaikan 
ja kirjoittaa tallennettavan mittapistetiedoston nimen. HUOM. kirjoita 
myös haluttu tiedostopääte: csv, txt tai pts. Oletus päätteenä on csv, 
mikäli päätettä ei anneta. Tallennus varmistaa aikaisemman 
samannimisen tiedoston korvaamisen.

• Mittapisteet on nyt tallennettu tiedostoon ja komentoikkunaan tulee 
ilmoitus montako mittapistettä on löytynyt ja montako mittapistettä on 
viety tiedostoon.
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Tee mittapiste

• Valitse, jos teetkö mittapisteet metripohjaiseen piirustukseen ts. 
piirustukseen, jonka piirustusyksikkö on metri. Mikäli piirustuksen 
piirustusyksikkö on millimetri, poista valinta ruudusta Tee metripohjalle.

• Voit halutessasi käyttää koodilistaa helpottamaan mittapisteiden 
piirtoasetusten valintaa, katso kohtaa Koodilista alempana.

• Valitse pistenumero. Keskimmäinen Numero- ruutu on pistenumeron 
juokseva numero-osa. Voit valita alkavan numeron vapaasti. Vasen ja 
oikea ruutu on juoksevaan numero-osaan liitettävä vakionimi. Nämä etu-
ja jälkiliitteet ovat valinnaisia.

• Valitse mittapisteen koodi halutessasi. Oletuskoodi on nolla (0).

• Valitse symbolin koko. Voit valita valmiin arvon pudotusvalikosta tai 
kirjoittaa haluamasi koon. Symbolin koko ilmoitetaan aina millimetreinä. 
Koko on symbolin halkaisija ja samalla mittapisteen attribuuttitietojen 
tekstin korkeus.

• Valitse mittapisteen symboli. Tässä versiossa on käytössä 7 valmiiksi 
määritettyä symbolia. Valinnan kohdalla oikeanpuoleisin ruutu näyttää 
symbolin nimeä vastaavan numeron, joka tulee myös mittapisteblokin 
nimeen ja mittapisteen kuvatason nimeen.

• Valitse mittapisteen väri. Tässä varsiossa on käytössä 12 eri väriä, jotka 
pitää valita pudotusvalikosta. Valinnan kohdalla oikeanpuoleisin ruutu 
näyttää symbolin väriä vastaavan numeron, joka tulee myös 
mittapisteblokin nimeen ja mittapisteen kuvatason nimeen.

• Valinnainen oma tasonimi, joka lisätään MxxPISTEET-kuvatason nimen 
perään. Ohjelma kirjoittaa kuvatason nimen ja oman nimen väliin ”_”-
merkin.

• Valitse, haluatko paksun symbolin ja pistenumeron. Mikäli piirustuksessa 
on jo määritetty sama mittapisteblokki (sama symboli-ja väri-
yhdistelmä), niin tämä valinta ei muuta aikaisemmin tehtyä valintaa. 
Mittapisteblokin määritykset voi muuttaa poistamalla mittapisteblokki ja 
tekemällä se uudelleen.

• Valitse, haluatko pienen symbolin tai tekstin. Pieni symboli ja teksti on 
kooltaan puolet alkuperäistä pienempi. Tätä määritystä koskee myös 
edellä mainittu.

• Valitse Koordinaatit pistenumeron ja koodin tilalle, jos haluat että 
mittapisteen pistenumeron ja koodin sijaan kirjoitetaan mittapisteen 
koordinaatit. 

• Keskitä automaattisesti- toimintoa voi käyttää, jos haluaa kuvaruutuun 
näkyviin kaikki piirustuksen sisältämät kohteet.
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• Jäädytä kuvatasot- toimintoa voit käyttää silloin, kun haluat piilottaa 
mittapisteen attribuuttitietoja. Tämä toiminto vaikuttaa vain niihin 
mittapisteisiin, mitä ollaan juuri käsittelemässä.

• Mikäli haluat tehdä mittapisteitä valitsemalla sijainnin kuvaruudulla, voit 
nyt tehdä sen painamalla Tee mittapiste- painiketta. Mikäli Symbolin 
koon valinta unohtui tehdä ts. Symbolin koko– ruutu on tyhjä, niin 
mittapistettä ei tehdä. 

• Käytä tartuntatoimintoja normaaliin tapaan, kun haluat sijoittaa 
mittapisteitä piirustusobjekteihin. 

• Komentoikkunassa näkyy kehoite Valitse piste! Siihen tulee myös 
ilmoitus viimeisestä käytetystä pistenumerosta.

• Lopeta mittapisteiden lisääminen painamalla enter (hiiren oikea painike).

• Mikäli haluat käyttää mittapisteen sijainnin määrittämiseen 
koordinaattiarvoja, niin kirjoita koordinaatit ruutuihin. HUOM! Nämä 
koordinaattiarvot ovat käänteiset verrattuna cad-koordinaatteihin ja aina 
metreinä. Paina lopuksi Tee mittapiste- painiketta.

• Mikäli haluat valita mittapisteen sijainnit kuvaruudulta ja käyttää itse 
määrittämääsi korkeutta, voit kirjoittaa haluamasi korkeuslukeman ja 
sitten valita kuvaruudulta sijainnin. Mittapiste sijoitetaan määrittämääsi 
korkeuteen riippumatta siitä millä korkeudella tartuntapiste on 
kuvaruudulla.

Poista mittapisteitä

• Toiminto poistaa mittapisteitä piirustuksesta, mittapisteblokin ja 
mittapisteblokkia vastaavat kuvatasot.

• Valitse poistettava mittapistejoukko valitsemalla symboli ja väri tai 
käyttämällä koodilistaa.

• Mikäli valittu mittapisteblokki löytyy piirustuksesta, niin ohjelma 
ilmoittaa poistettavan mittapistejoukon nimen ja varmistaa poiston. 
Mittapisteet poistetaan välittömästi. Mikäli valittua mittapisteblokkia ei 
löydy piirustuksesta, tulee näkyviin ilmoitus. Valittu mittapisteblokki voi 
olla olemassa piirustuksessa vaikka mittapisteitä ei ole kuvaruudussa. 
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Tällöin tulee myös ilmoitus, että mittapisteitä ei löytynyt. 
Komentoikkunaan tulee ilmoitus montako mittapistettä on poistettu.

• Valitse Poista mittapisteblokit, mikäli haluat mittapisteiden lisäksi poistaa 
myös vastaavan mittapisteblokin. Komentoikkunaan tulee ilmoitus myös 
mittapisteblokin poistamisesta. Valinta tehdään ennenkuin painiketta 
Poista mittapisteitä painetaan.

• Valitse vielä Poista kuvatasot, mikäli haluat poistaa mittapistettä 
vastaavat kuvatasot. Komentoikkunaan tulee lisäksi ilmoitus kuvatasojen 
poistamisesta. Kuvatasoja ei voi poistaa, jos ei poisteta ensin 
mittapisteblokkeja. Sen vuoksi kuvatasopiston valinta ei ole mahdollinen 
ellei ole tehty valintaa Poista mittapisteblokit.

• Poista viimeisin mittapiste- toiminto poistaa mittapisteitä yksitellen 
käänteisessä luontijärjestyksessä. Ensimmäinen poisto muuttaa 
pistenumeroa siten, että voit jatkaa pisteiden poimimista poistetun 
pisteen pistenumerolla.
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Koodilista

MPisteessä on mahdollisuus käyttää koodilistaa, joka on tallennettu C-aseman 
juureen. Tiedoston nimi on vakio, koodilista.csv. Koodilistan avulla voit helposti 
määrittää mittapisteiden piirtoasetukset koodin avulla. Voit asettaa koodit 
aktiiviseksi valitsemalla koodit päällä- valinnan. Kun koodit ovat päällä, 
ohjelma valitsee pisteiden piirtoasetukset koodilistaan tehtyjen valintojen 
mukaisesti. Käyttäjä voi itse muokata koodilistan kunkin käyttötilanteen 
mukaiseksi. Koodilistaa voi muokata mm. tekstieditorilla tai 
taulukkolaskentaohjelmalla ja tallentamalla sen csv-muotoisena C-aseman 
juureen. Alla on malli koodilistasta, joka tulee asennuksen yhteydessä.

1,Risti,Punainen,1500,on,on,off,omatasonimi1

2,Ympyrä,Sininen,2000,off,on,off,omatasonimi2

3,Rasti,Vihreä,3000,on,off,off,omatasonimi3

4,Neliö,Vihreä,5000,off,off,off,omatasonimi4

5,Neliö+rasti,Valkoinen,1000,on,on,on,omatasonimi5

Koodilistan tiedot pitää olla pilkulla erotettuja ja tietyssä järjestyksessä:

• koodi- mikä tahansa merkkijono (Huom. koodi=KOODI)

• symboli- täsmällinen symbolinimi, mallin voi katsoa symbolin valinta-
kohdasta

• väri- täsmällinen värin nimi, huomio iso alkukirjain, koskee myös 
symbolia

• symbolin koko- koko annetaan millimetreinä

• paksu symboli ja pistenumero- on=käytetään, off=ei käytetä

• pieni symboli- on=käytetään, off=ei käytetä

• pieni teksti- on=käytetään, off=ei käytetä

• oma tasonimi= vakio tasonimeen lisättävä selite, _-merkki tulee 
automaattisesti oman tasonimen eteen

Koodit toimivat kaikissa näissä toiminnoissa:

• Tee mittapiste

• Poista mittapisteitä

• Tuo mittapisteitä

Toiminnoissa Tee mittapiste ja Tuo mittapisteitä voit kuitenkin muuttaa 
symbolin kokoa vaikka se on koodilistalla jo määritetty. 
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Samalla koodilla ei voi olla erilaisia piirtoasetuksia, mutta eri koodeilla voi olla 
samat piirtoasetukset. Voit luoda eri tilanteisiin useita erilaisia koodilistoja, 
mutta käytössä voi olla kerrallaan vain yksi, joka on vakionimellä tallennettuna 
C-aseman juureen. Voit esimerkiksi pitää tallessa erilaiset koodilistat omassa 
kansiossa niitä kuvaavilla nimillä ja tarvittaessa ottaa käyttöön tallentamalla 
koodilista nimellä koodilista.csv C-aseman juureen. Korvaat siis siellä olevan 
toisella tiedostolla.

Koodilista tuo mittapisteet- toiminnossa

Koodilistan avulla voit tehdä mittapisteen piirtoasetukset valitsemalla koodin 
valintalistalta. Mikäli haluat käyttää asetettua koodia kaikille tuotaville 
mittapisteille, niin ota asetusten tekemisen jälkeen rasti pois kohdasta ”Koodit 
päällä” sen jälkeen, kun olet tehnyt piirtoasetusten valinnan. Jos koodit päällä 
-asetus on käytössä tuontitoiminnossa, niin tuotaville mittapisteille asetetaan 
koodilistan mukaiset piirtoasetukset mittapisteen koodin perusteella. Jos 
pistelistauksen koodi löytyy koodilistalta, niin vastaavaa asetusta käytetään 
kyseiselle mittapisteelle. Mikäli mittapisteen koodia ei löydy pistelistalta, niin 
käytettävä mittapisteen piirtoasetus tulee koodilistan ensimmäiseltä riviltä.

Koodilistan käyttäminen tässä toiminnossa hidastaa hieman tuontia.

Mittapisteiden käsittely Progecadin omilla toiminnoilla

Tässä osiossa selostetaan muutamia Progecadin toimintoja , joilla voi käsitellä 
mittapisteitä. Toimintojen tarkempi ohjeistus löytyy Progecadin helpistä.

Tasojen hallinta

Tasojen hallinnan kautta voit hallita mittapisteiden lukitusta ja näkyvyyttä. Voit 
käyttää sitä Tools->progeCAD Explorer kautta tai Entity Properties toolbarin 
Layer Controlin kautta. MPiste lukitsee kaikki mittapistekuvatasot. Voit avata 
kuvatasoja lock/unlock- toiminnolla. Voit myös säätää näkyviin mittapisteen 
tietoja samoista työkaluista käyttämällä freeze/thaw-toimintoja.

Mittapisteiden käsittelyyn riittää kuvatason MxxxPISTEET lukitus tai jäädytys. 
Mikäli haluat siirtää mittapisteen tekstejä eri paikkaan, niin vapauta lukitus 
MxxxPISTEET-kuvatasolta, valitse mittapiste ja siirrä halumasi tekstit toiseen 
sijaintiin.

ProgeCAD Explorerin kautta voit myös korjata väärät tasonimet ja poistaa 
vahingossa syntyneitä kuvatasoja. Mittapisteiden käsiteltävyyden 
varmistamiseksi on vältettävä tasonimien muuttamista.

Ominaisuuksien hallinta

Properties-ikkunassa voit nähdä ja käsitellä piirustusobjektien ominaisuuksia.
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 Myös muutamia mittapisteiden ominaisuuksia voi käsitellä. Kaikki tehdyt 
muutokset vaikuttavat vain valittuihin mittapisteisiin. Näitä ominaisuuksia ovat 
lähinnä Geometry kohdan Position X, Y ja Z, ja Scale X,Y, Misc-kohdan 
Rotation ja Attributes-kohdan ominaisuudet.

Position kohdassa voit siis muuttaa mittapisteen sijainnin. On huomattava, 
että Z-arvon muuttaminen muuttaa vain mittapisteen korkeutta ja on se arvo, 
joka tallentuu tiedostoon mittapistelistauksessa. Attributes-kohdan arvo 
KORKEUS ei muutu samalla, vaan tarvittaessa myös se tulee muuttaa.

Scale X ja Scale Y arvot ilmoittavat mittapisteen symbolin koon metreinä. 
Muuttamalla näitä arvoja symbolin koko muuttuu. Mittapisteen tekstien koko ei 
muutu. Käytä tätä harkiten tai tuo pisteet uudelleen piirustukseen, jos koko on 
väärä.

Rotation muuttaa symbolin asentoa. Ei vaikuta tekstien asentoon. 

Attributes-kohdassa voit muuttaa yksittäisen pisteen pistenumeron. 
Valitsemalla useita mittapisteitä voit muutta yhdellä kertaa koodit. KORKEUS-
arvon muuttaminen ei muuta mittapisteen korkeusasemaa eikä tämä arvo ole 
se luku joka tallentuu tiedostoon. Oletusarvoisesti tämä luku on kuitenkin 
sama kuin Position Z ellei jompaa kumpaa ole muutettu.

Properties-ikkunan yläoikeassa kulmassa on painike Quick Selection. Tämän 
toiminnon avulla voit näppärästi tehdä joukkovalintoja annettujen määritysten 
mukaisesti. Mittapisteitä voi valita tekemällä valinnat Element Type-Insert, 
Properties-Layer ja Value arvoksi halutun mittapisteblokin kuvatasonimi. Tässä 
tapauksessa nimi on siis MxxxPISTEET.

Mittapisteen tekstien muuttaminen

Mittapisteen attribuuttien muuttaminen voi tapahtua seuraavasti: valitse 
mittapiste, paina hiiren oikeaa painiketta, valitse komento Single. Edit Block 
Attributes-ikkuna avautuu. Muuta haluamasi tiedot.

Toinen tapa on tuplaklikata mittapistettä hiiren vasemmalla painikkeella. 
Enhanced Attribute Editor-ikkuna avautuu. Tässä voidaan muuttaa tiedot kuten 
edellä ja lisäksi joitakin muita ominaisuuksia. Käytä niitä harkiten.

Mittapisteen siirtäminen

Voit siirtää mittapistettä, kun kuvataso MxxxPISTEET on avattu lukituksesta. 
Siirrä mittapistettä raahaamalla tai move-käskyllä haluttuun paikkaan. 
Huomioi edelliset huomautukset korkeusarvosta.

Mittapisteen poistaminen

Voit poistaa yksittäsiä pisteitä tai valittuja joukkoja delete-käskyllä. Kokonaiset 
joukot poistuvat näppärämmin MPisteen toiminnolla Poista mittapisteitä.
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Mittapisteen etsiminen

Löydät piirustuksesta mittapisteen helposti käyttämällä käskyä Find tai 
käynnistämällä sen valikosta Edit->Find and replace. Kirjoita ruutuun 
hakemasi pisteen pistenumero ja paina Find. Jos löytyi, niin tekstiruutuun 
tulee hakemasi teksti. Paina sitten Zoom to ja ikkuna zoomaa ja keskittää 
etsittyyn pisteeseen.

Mittapisteen symbolin ja pistenumeron paksuuden säätäminen

Jos olet asettanut valinnan Paksu symboli ja pistenumero, niin voit edelleen 
säätää viivanleveyden esittämistä näytössä ja tulosteessa. Näytössä voit 
säätää viivanleveyden valitsemalla valikosta Tools->Drawing settings-
>Display->Lineweights(Change settings for) ja säätämällä liukusäätimestä 
sopivan viivanleveyden näytössä. Tulosteessa voit valita tulostusasetuksissa 
tulostuuko viivanleveydet vai ei. Mikäli tarvitset lisää hienosäätöä 
viivanleveyksiin, voit tasohallinnassa (Progecad explorer) säätää jokaisen 
mittapisteen ominaisuuden ja symbolin viivanleveyttä erikseen. Esivalittu 
viivanleveys on 0,5 mm.

Varoitus

Ottamalla huomioon aikaisemmin kerrotut asiat ja käsittelemällä mittapisteitä 
Progecadin omilla toiminnoilla mahdollisimman vähän vältetään menettämästä 
MPisteen mahdollistamia toimintoja. Harkitse oikea symbolin koko ja malli 
sekä lisäominaisuudet kuten oma kuvatasonimi etukäteen ja tuo mittapisteet 
kuvaan. Säädä tekstien sijainteja tarvittaessa, käännä symbolin asento, korjaa 
pistenumeroita ja koodeja. Kokeile muita toimintoja harjoitusaineistolla.

16


